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How to Read the Manuals

Symbols used in the manuals

This manual uses the following symbols:

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

ﬁ

Indicates supplementary explanations of the machine's functions, and instructions on resolving user

errors.

=) Reference

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[]

Indicates the names of keys on the machine's display or control panels.

>

Indicates the key sequence order you should perform using the control panel.
Example:

Select [System] P Press [OK]

(Select [System], and then press the [OK] key.)

P Region A\ (mainly Europe and Asia)

@D Region B (mainly North America)

Differences in the functions of Region A and Region B models are indicated by two symbols. Read the
information indicated by the symbol that corresponds to the region of the model you are using. For
details about which symbol corresponds to the model you are using, see page 6 "Model-Specific
Information".



Model-Specific Information

This section explains how you can identify the region your machine belongs to.

There is a label on the rear of the machine, located in the position shown below. The label contains
details that identify the region your machine belongs to. Read the label.

DBH040

The following information is region-specific. Read the information under the symbol that corresponds to
the region of your machine.

@@ Region A\ (mainly Europe and Asia)

If the label contains the following, your machine is a region A model:
e CODE XXXX -27
* 220-240V

@D Region B (mainly North America)

If the label contains the following, your machine is a region B model:
e CODEXXXX-17
e 120-127V

* Dimensions in this manual are given in two units of measure: metric and inch. If your machine is a
Region A model, refer to the metric units. If your machine is a Region B model, refer to the inch
units.



Names of Major Features

In this manual, major features of the machine are referred to as follows:

o Auto Document Feeder = ADF






1. What You Can Do with This Machine

You can search for a description by what you want to do.

| Want to Save Paper

______

BRLO059S

Printing multi-page documents on both sides of sheets (Duplex Copy)
= See "Duplex Copying", Copy@.

Printing multi-page documents on a single sheet (Combine)
= See "Combined Copying", Copy@.

Printing received faxes on both sides of sheets (2 Sided Print)
= See "Two-Sided Printing", Fax®.

Sending files from the computer without printing them (LAN-Fax)

= See "Sending Fax Documents from Computers", Fax®.



1. What You Can Do with This Machine

| Want to Convert Documents to Electronic
Formats Easily

) |

BQX138S

Sending scan files

= See "Basic Procedure for Sending Scan Files by E-mail", Scan®.
Storing scan files in a shared folder

= See "Basic Procedure for Using Scan to Folder", Scan®.
Storing scan files on media

= See "Storing the Scanned Documents on a USB Flash Memory Device", Scan®.



| Want to Register Destinations

| Want to Register Destinations

=
o

XX@aaa.bbb.ccc

2

=
IP192.169.1.10

01-2345-XXXX

—

Using the control panel to register destinations in the Address Book

BRLO60S

= See "Registering Addresses and Users for Facsimile/Scanner Functions ", Connecting the

Machine/ System settings@®.

Downloading destinations registered in the machine to the LAN-Fax driver destination list

= See "Using the machine's Address Book as the LAN-Fax destination list", Fax®.




1. What You Can Do with This Machine

| Want to Operate the Machine More
Effectively

/:

4

Registering frequently-used printing settings to the printer driver

= See "Using One Click Presets", Print®.

BQX139S8

Changing the initial settings of the printer driver to frequently-used printing settings

= See "Displaying the Printing Preferences Dialog Box", Print@.



You Can Make Copies Using Various Functions

You Can Make Copies Using Various Functions

#Q

I

CMQ002

* You can reduce or enlarge the copy image. With the Auto Reduce/Enlarge function, the machine
automatically calculates the reproduction ratio based on the sizes of the originals and the paper
you have specified.

= See "Reducing or Enlarging Originals", Copy@.

* Copier functions such as Duplex and Combine allow you to save on paper by copying multiple
pages onto single sheets.

= For details about duplex copying, see "Duplex Copying", Copy@.

= For details about combined copying, see "Combined Copying", Copy@.
* You can copy onto various types of paper such as envelopes.

= See "Copying onto Various Types of Paper Using the Bypass Tray", Copy@.
* You can sort copies.

= See "Sort", Copy@.



1. What You Can Do with This Machine

You Can Print Data Using Various Functions
ik
dl

* This machine supports network and local connections.

CMQ004

* You can collate printed paper.

= See "Collate", Print®.



You Can Use the Scanner in a Network Environment

You Can Use the Scanner in a Network
Environment

i

CJQs07

74 0\~\§ e

* You can send scan files to a specified destination using e-mail (Sending scan files by e-mail).
= See "Basic Procedure for Sending Scan Files by E-mail", Scan@.
* You can send scan files directly to folders (Sending scan files by Scan to Folder).

= See "Basic Procedure for Using Scan to Folder", Scan®.



1. What You Can Do with This Machine

You Can Prevent Information Leakage
(Security Functions)

CJQ608

* By setfting passwords, you can prevent unauthorized access via the network.

[ Reference )
* See Security Guide®.



You Can Monitor and Set the Machine Using a Computer

You Can Monitor and Set the Machine Using a
Computer

Using Web Image Monitor, you can check the machine's status and change the settings. -

CJQ6B09

You can check which tray is running out of paper, register information in the Address Book, specify the

network settings, and configure the system seftings.

* See "Using Web Image Monitor", Connecting the Machine/ System Settings@.
* See Web Image Monitor Help.



1. What You Can Do with This Machine




2. Getting Started

This chapter describes how to start using this machine.

Guide to Names and Functions of Components

Guide to Components

ACAUTION

¢ Do not obstruct the machine's vents. Doing so risks fire caused by overheated internal

components.

Exterior: Front view

DBHO030
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2. Getting Started

1. ADF
Lower the ADF over originals placed on the exposure glass.
If you load a stack of originals in the ADF, the ADF will automatically feed the originals one by one.
2. ADF cover
Open this cover to remove originals jammed in the ADF.
3. Input tray for the ADF
Place stacks of originals here.
4. Extender for the ADF tray
Extend this when placing paper longer than A4 in the input tray for ADF.
5. Exposure glass
Place originals face down here.
6. Cover for the exposure glass
Open this cover to place originals on the exposure glass.
7. Output tray for the ADF
Originals scanned with the ADF are output here.
8. Stop fence for the ADF
Pull out this fence to prevent originals from falling off.
9. Control panel
See page 25 "Guide to the Names and Functions of the Machine's Control Panel".
10. Standard tray
Copied/printed paper and fax messages are delivered here.
11. Media slot
Insert a USB flash memory device.
12. Ventilation holes
Prevent overheating.
13. Front cover open button
Push this button to open the front cover.
14. Front cover
Open to access the inside of the machine and remove jammed paper.
Open here to replace the toner cartridge and the drum unit.
15. Lower paper tray (option)
Load paper here.
16. Tray 1
Load paper here.
17. Main power switch

To operate the machine, the main power switch must be on. If it is off, turn the switch on.



Guide to Names and Functions of Components

18.

19.

20.

21.

22.

Bypass tray open lever

Push this lever to open the bypass tray.

Tray Extension

Pull this fence to prevent paper from falling off.

Bypass tray

Use to copy or print on thick paper, OHP transparencies, envelopes, and label paper (adhesive labels).
Extender for the bypass tray

Pull this extender out when loading A4l 81/, x 1100 or larger size paper in the bypass tray.

Paper guides

When loading paper in the bypass tray, align the paper guides flush against the paper.

Exterior: Rear view

DBHO031

. Ventilation holes

Prevent overheating.

Power connector

Connect the power cord to the machine. Insert the other end into an electrical outlet.
Rear cover open lever

Pull this lever to open the rear cover.

Rear cover

Open to access the inside of the machine and remove jammed paper.
Open here to replace the fusing unit.

External telephone connector

For connecting an external telephone.

Line interface connector

For connecting a telephone line.

21



2. Getting Started

USB 2.0 [Type B] port

Use a USB cable to connect the machine to a computer.

Security slot

Connect a security cable to prevent theft.

Ethernet port

Use a network interface cable to connect the machine to a network.
Slot

Optional wireless LAN interface unit can be inserted.

Interior: Front view

22
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Toner cartridge

Pull out the toner cartridge and remove jammed paper.

Messages appear on the screen when the toner cartridge needs to be replaced, or a new cartridge needs to
be prepared.

For details about the messages that appear on the screen when consumables need to be replaced, see
"Replenishing and Replacing Consumables", Maintenance and Specifications@.

¢ When you remove jammed paper, pull out the toner cartridge with the drum unit. If you want to remove
only the toner cartridge, pull down the lever on the right side of the toner cartridge, and then pull the
toner cartridge out.

Drum unit

Messages appear on the screen when the drum unit needs to be replaced, or a new drum unit needs to be
prepared.

For details about the messages that appear on the screen when consumables need to be replaced, see
"Replenishing and Replacing Consumables", Maintenance and Specifications@.



Guide to Names and Functions of Components

Interior: Rear view

1.

DBH033

Fusing unit

Pull out the fusing unit and remove jammed paper.

Messages appear on the screen when the fusing unit needs to be replaced, or a new fusing unit needs to be
prepared.

For details about the messages that appear on the screen when consumables need to be replaced, see

"Replenishing and Replacing Consumables", Maintenance and Specificoﬁons@.

The fusing unit is included in Maintenance Kit.

23



2. Geftting Started

Guide to Functions of the Machine's Options

Guide to Functions of the Machine's External Options

-

DBH086

1. Handset@Region B (mainly North America)

Used as a receiver.

Allows you to use the Manual Dial functions. It also allows you to use the machine as a telephone.

2. Lower paper tray

You can install a 250-sheet paper feed unit or a 500-sheet paper feed unit.

24



Guide to the Names and Functions of the Machine's Control Panel

Guide to the Names and Functions of the
Machine's Control Panel

This illustration shows the control panel of the machine with options fully installed.
Search @ Detail

7
Destination @ Standard ®

&
heck
| | I | Fax Received  Communicating |

15 1617 18 19 20 21 22 23 24 25262728 29 30 3132

DBHO001

1. [ID Card Copy] key
Press to jump to the ID card copy setting menu.
2. [Job Information] key (scanner and facsimile mode)
Press to obtain status information on transmitted data.
3. Original Selection key (copier, scanner and facsimile mode)
Press to select the most suitable scanning method for the original.
4. Color Selection key
Press to scan originals in full color.
5. [Duplex/Combine/Series] key (copier mode)
e Duplex
Perform duplex printing when copying a multiple-sheet original.
¢ Combine
Combines and prints the pages of a multiple-sheet original onto a single sheet.
e Series
Prints each page of a double-page spread as a single-page copy.
6. [Copy] key
Press to activate the copy function.
7. [Facsimile] key
Press to activate the facsimile function.
8. [Scanner] key

Press to activate the scanner function.

25
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2. Getting Started

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Scroll keys
Press these keys to move the cursor in each direction.

When the [2][Y 1™ ] [*] keys appear in this manual, press the applicable key for the direction that you
want to move the cursor.

[Pause/Redial] key (facsimile mode)

* Pause

Press to insert a pause in a fax dialing sequence. The pause is indicated by “-".
¢ Redial
Press this to select a recently-dialed destination.

[On Hook Dial] key (facsimile mode)
Press to use the On Hook Dial function.
[Reset] key
Press to clear the current settings.
Main power indicator
The main power indicator goes on when you turn on the main power switch.
[User Tools] key
Press to change the default settings to meet your requirements.
Quick Dial keys
Press to enter letters and symbols.
Press to select the registered destination at a single touch.
[Search Destination] key (scanner and facsimile mode)
Press to search for a destination registered in the destination list.
[Check Destination] key (scanner and facsimile mode)
Press to check the specified destination.
Resolution Selection key (facsimile mode)
Press to specify the resolution of the fax.
Density Selection keys (copier, scanner, and facsimile mode)
Press to adjust the scanning density under the copier, scanner, and fax functions.
[Sort] key (copier mode)
Press to automatically sort printed copies.
[Printer] key
Press o activate the printer function.
Fax Received indicator (facsimile mode)

Lights continuously while data other than personal box or Memory Lock file is being received and stored in the
fax memory.

Communicating indicator (facsimile mode)

Lights continuously during data transmission and reception.



Guide to the Names and Functions of the Machine's Control Panel

24.

25.

26.

27.

28.

29.

30.

31.

32.

Selection keys
Correspond to items on the display. Press to select the corresponding item.
Data In indicator
Flashes when the machine is receiving print jobs or LAN-Fax documents from a computer.
[Escape] key
Press to cancel an operation or return to the previous display.
Alert Indicators
Lights up when a machine error occurs.
Steady red: printing is not possible, or is possible but print quality cannot be ensured.
Flashing yellow: the machine will soon require a replacement consumable.
[OK] key
Press to set a selected item or an entered numeric value.
Number keys
Use to enter the numbers for copies, fax numbers, and data for the selected function.
[#] key (Enter key)
Press to confirm values entered or items specified.
[Start] key
Press to start copying, printing, scanning, or sending.
[Clear/Stop] key

e Clear

Clears an entered numeric value.
e Stop

Stops a job in progress, such as copying, scanning, faxing, or printing.

27
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2. Getting Started

Changing the Display Language
You can change the language used on the display. English is set as default.
Press the [User Tools] key, and then select the sefting items using the [Y ] or [4 ] key.

1. Select [Language] » Press [OK]

2. Select the language you want to use » Press [OK]



Turning On/Off the Power

Turning On/ Off the Power

The main power switch is on the front side of the machine. When this switch is turned on, the main power
turns on and the main power indicator on the right side of the control panel lights up. When this switch is
turned off, the main power turns off and the main power indicator on the right side of the control panel

goes out. When this is done, machine power is off. Fax files in memory may be lost if you turn this switch

off. Use this switch only when necessary.

Turning On the Main Power

* Do not turn off the main power switch immediately after turning it on. Doing so may result in

damage to the memory, leading to malfunctions.

1. Make sure the power cord is firmly plugged into the wall outlet.
2. Push the main power switch.

The main power indicator goes on.

DBH057

Turning Off the Main Power

A\ CAUTION

* When disconnecting the power cord from the wall outlet, always pull the plug, not the cord.

Pulling the cord can damage the power cord. Use of damaged power cords could result in fire
or electric shock.

e After turning the machine's power off, wait at least a few seconds before turning it back on.

29
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2. Getting Started

* Before unplugging the power cord plug, turn off the main power switch and make sure the main
power switch indicator turns off. Not doing so may result in damage to the memory, leading to
malfunctions.

* Do not turn off the power while the machine is in operation. Doing so may result in damage to the
memory, leading fo malfunctions.

* Do not hold down the main power switch while turning off the main power. Doing so forcibly turns
off the machine's power and may damage the memory and cause malfunctions.
1. Push the main power switch.

The main power indicator goes out.



Placing Originals

Placing Originals

Placing Originals on the Exposure Glass

/A CAUTION

* Keep your hands away from the hinges and exposure glass when lowering the ADF. Not doing

so may result in an injury if your hands or fingers are pinched.

* Do not lift the ADF forcefully. Otherwise, the cover of the ADF might open or be damaged.

1. Lift the ADF.

2. Place the original face down on the exposure glass. The original should be aligned to the
rear left corner.

Start with the first page to be scanned.

=

DBH073

1. Positioning mark

3. Lower the ADF.

Placing Originals in the Auto Document Feeder

Be sure not to load the original untidily. Doing so may cause the machine to display a paper misfeed
message. Also, be sure not to place originals or other objects on the top cover. Doing so may cause a
malfunction.
1. Adjust the original guides to the original size.
2. Place the aligned originals squarely face up in the ADF.
Do not stack originals beyond the limit mark.

The first page should be on the top.

31



2. Geftting Started

When placing originals that are longer than A4D3 or 81/, x 1152, open the extenders.

u

1

DBH075

1. Limit mark

2. Original guides

32



3. Copy
|

This chapter describes frequently used copier functions and operations. For the information not included

in this chapter, see Copy@ on the supplied CD-ROM.

Basic Procedure

To make copies of originals, place them on the exposure glass or in the ADF.

When placing the original on the exposure glass, start with the first page to be copied. When placing
the original in the ADF, place them so that the first page is on the top.

About placing the original on the exposure glass, see page 31 "Placing Originals on the Exposure
Glass".

About placing the original in the ADF, see page 31 "Placing Originals in the Auto Document Feeder".

To copy onto paper other than plain paper, specify the paper type in User Tools according to the weight
of the paper you are using. For details, see "System Settings", Connecting the Machine/ System Settings

The following procedure explains copying onto paper whose size and orientation matches that of the
originals exactly.

1. Press [Copy]

DBHO11

2. Make sure no previous settings remain

When there are previous settings remaining, press the [Reset] key.

R/E  |Auto R/E

3. Place the originals

1EJA4 LI (P lain]
[1003]

4. Make desired settings

33



3. Copy

5. Enter the number of copies with the number keys
6. Select the paper tray
7. Press [Start]

When placing the original on the exposure glass, press the [#] key after all originals are scanned.

8. When the copy job is finished, press [Reset] to clear the settings

DBHO19
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Reducing or Enlarging Originals

Reducing or Enlarging Originals

This section describes methods of reducing or enlarging images by specifying a reproduction ratio, or a
paper size.

Base Point

The base point of reduce/enlarge differs depending on how the original is scanned. When the
original is placed on the exposure glass, the upper left corner will be the base point. When it is
placed in the ADF, the bottom left corner will be the base point.

¢ Placing the original on the exposure glass

[N

Pol

CKN005

¢ Placing the original in the ADF

CXcoo7

Preset Reduce/Enlarge

This function allows you to reduce or enlarge images by selecting a preset ratio.

B

KX
1>
-

}~

11k

CKNO004
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3. Copy

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

—

. Press [R/E]
Press [Enlarge] or [Reduce]
Select a ratio P Press [OK]

Select the paper tray

o M 0N

Place the originals P Press [Start]

Zoam

36

You can specify the reproduction ratio in increments of 1%.
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Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

—

. Press [R/E].

N

. Press [Zoom].

3. Enter the desired ratio with the number keys P Press [OK]

Pressing the [Y ] or [4 ] key changes the ratio in increments of 1%. Pressing and holding down the

[Y ] or [* ] key changes it in increments of 10%.
4. Select the paper tray
5. Place the originals P Press [Start]

Auto Reduce/Enlarge

The machine automatically calculates the reproduction ratio based on the sizes of the originals and the
paper you have specified. The machine will enlarge or reduce the image of the originals to fit them to
the paper.



Reducing or Enlarging Originals
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* Ifyou select a reproduction ratio after pressing [Auto R/E], the Auto Enlarge/Reduction funciion is
canceled.

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.
1. Specify the original size
For details, see "Specifying Original Sizes", Copy@.
2. Press [Auto R/E]
3. Select the paper tray

4. Place the originals P Press [Start]
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Duplex Copying

Copies two one-sided pages or one two-sided page onto a two-sided page.
* Copying one two-sided page on one two-sided page is available for SP 36 10SF only.

* You cannot use the bypass tray with this function.

}

For SP 36 10SF, two types of Duplex are available.
1Sided Orig.->Duplex Copy

Copies two one-sided pages on one two-sided page.
2Sided Orig.->Duplex Copy

Copies one two-sided page on one two-sided page.

The resulting copy image will differ according to the orientation in which you place your originals ([0 or

Original orientation and completed copies

To copy on both sides of the paper, select the original and copy orientation according to how you
want the printout to appear.
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Duplex Copying
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Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

1. Press [Duplex/Combine/Series].
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2. Select the duplex mode P Press [OK]
3. Select the paper tray
4. Place the originals P Press [Start]
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Combined Copying

This mode can be used to select a reproduction ratio automatically and copy the originals onto a single

sheet of copy paper.
The machine selects a reproduction ratio between 25 and 400%.
Orientation of the original and image position of Combine

The image position of Combine differs according to original orientation and the number of originals

to be combined.

o Portrait (7) originals

4

CNU005

* Landscape () originals

4

Placing originals (originals placed in the ADF)

The default value for the copy order in the Combine function is "From Left to Right". To copy
originals from right to left in the ADF, place them upside down.

¢ Originals read from left to right



Combined Copying
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One-Sided Combine

Combine several pages onto one side of a sheet.

¢ Combine Copies function from two-sided originals is available for SP 3610SF only.

il
|

}
.1

CKNO014

There are following types of One-Sided Combine.
For SP 3610SF
Combine: 2 Orig.t1-*[Z]
Copies two one-sided originals to one side of a sheet.
Combine: 4 Orig.t1->E]

Copies four one-sided originals to one side of a sheet.
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Combine 1 Orig.t [
Copies one two-sided originals to one side of a sheet.
Combine: 2 Orig.ti>El
Copies two two-sided originals to one side of a sheet.
For SP 3600SF
Combine 1 Side (2 Orig.)
Copies two one-sided originals to one side of a sheet.
Combine 1 Side (4 Orig.)
Copies four one-sided originals to one side of a sheet.

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

1. Press [Duplex/Combine/Series]

qrurnn)

2. Select the combine mode P Press [OK]

3. Select the paper tray

4. Place the originals P Press [Start]

* You cannot apply this function to sheets longer than 356 mm (14 inches) fed from the bypass tray.

* The default setting for the original orientation is the unreadable direction (=) When placing
originals in an unreadable direction, specify the original orientation. To specify the orientation,
select [Always Specify] for [Orientation] in [Copier Features], and then perform the following
procedure after Step 2. For details about the setting item, see "Copier Features", Copy@.

1. Select the original orientation P Press [OK]

* When placing originals on the exposure glass, press the [#] key after all the originals have been
scanned.

* To cancel the One-Sided Combine function, press the [Duplex/Combine/Series] key twice.
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Combined Copying

Two-Sided Combine

Combines various pages of originals onto two sides of one sheet.
 The Combine Copies function for two-sided originals is available for SP 36 10SF only.

* You cannot use the bypass tray with this function.

CKN074

There are following types of Two-Sided Combine.
For SP 3610SF
Combine: 4 Orig.A->[F:
Copies four one-sided originals to one sheet with two pages per side.
Combine: 8 Orig.t] Bk
Copies eight one-sided originals to one sheet with four pages per side.
Combine: 2 Origf}:'}[;lz
Copies two two-sided originals to one sheet with two pages per side.
Combine: 4 Orig.tt—> Bk
Copies four two-sided originals to one sheet with four pages per side.
For SP 3600SF
Combine 2 Side (4 Orig.)
Copies four one-sided originals to one sheet with two pages per side.
Combine 2 Side (8 Orig.)
Copies eight one-sided originals to one sheet with four pages per side.

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.
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1. Press [Duplex/Combine/Series]

qranend

2. Select the combine mode P Press [OK]
3. Select the paper tray
4. Place the originals > Press [Start]

* The default setting for the original orientation is unreadable direction (=lf=). When placing
originals in unreadable direction, specify the original orientation. To specify the orientation, select
[Always Specify] for [Orientation] in [Copier Features], and then perform the following procedure
after Step 2. For details about the setting item, see "Copier Features", Copy@.

1. Select the original orientation P Press [OK]
2. When copying two-sided documents, select the original orientation » Press [OK]
3. Select the duplex orientation P Press [OK]

* When placing originals on the exposure glass, press the [#] key after all the originals have been
scanned.

* To cancel the Two-Sided Combine function, press the [Duplex/Combine/Series] key twice.
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Copying onto Custom Size Paper from the Bypass Tray

Copying onto Custom Size Paper from the
Bypass Tray

Paper that has a horizontal length of 60.0-216.0 mm (2.37-8.50 inches) and a vertical length of
127.0-900.0 mm (5.00-35.43 inches) can be fed in from the bypass tray.

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

1. Load the paper face up in the bypass tray
2. Press [H#]

DBHO089

Select [Paper Size] P Press [OK]

Select [Custom Size] P Press [OK]

Enter the horizontal size with the number keys P Press [OK]
Enter the vertical size with the number keys P Press [OK]
Press [H]

Select [Paper Type] P Press [OK]

Specify the type of the paper as necessary P Press [OK]

© 0 ® N o U ~
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Place the originals P Press [Start]

When the copy job is finished, press the [Reset] key to clear the settings.
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Copying onto Envelopes

This section describes how to copy onto regular size envelopes. Place the original on the exposure glass
and place the envelope in the bypass tray.

Specify the thickness of the paper according to the weight of the envelopes you are printing on. For
details about the relationship between paper weight and paper thickness and the sizes of envelopes that
can be used, see "Recommended Paper Sizes and Types", Paper Specifications and Adding Pcper@.

About handling envelopes, supported envelope types, and how to load envelopes, see page 93
"Envelopes".

Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

1. Load the envelope with the side you want to copy face up in the bypass tray

2. Press [#]

DBH089

Select [Paper Size] P Press [OK]

Select [Regular Size] P Press [OK]

Select the envelope size P Press [OK]

Press [H]

Select [Paper Type] » Press [OK]

Select [Thick Paper 1] or [Thick Paper 2] » Press [OK]

0 © N o O~

Place the originals P Press [Start]



Sort

Sort

The machine assembles copies as sets in sequential order.
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Press the [Copy] key, and then select the setting items using the [Y ] or [4 ] key.

DBH009

2. Enter the number of copy sets using the number keys
3. Select the paper tray
4. Place the originals P Press [Start]
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4. Fax
]

This chapter describes frequently used facsimile functions and operations. For the information not
included in this chapter, see Fax@ on the supplied CD-ROM.

Basic Procedure for Transmissions (Memory
Transmission)

This section describes the basic procedure for transmitting documents using Memory Transmission.

Transmission starts automatically after the original is stored in memory. You can also send the same

original to several destinations (broadcasting). u

Yourmacmre Destination
2 ~L.g
EH Destination
=  LE
Destination
—_LE

CJN004

* Itis recommended that you call the receivers and confirm with them when sending important

documents.

* |f memory is full (0% appears at the upper right of the screen), Memory Transmission is disabled.
Use Manual Transmission instead. For details, see "On Hook Dial" or "Manual Dial", Fax®.

* If the combined total number of programmed destinations exceeds the maximum value, you cannot

transmit documents.

* If you press the [Clear/Stop] key or an original jams in the ADF during scanning, the pages of the
same set of originals that have been already scanned and saved in memory are deleted.

* If memory runs out during scanning, the machine stops scanning and a confirmation message

appears. For details, see " If memory runs out while storing originals", Fax®.
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Sending Originals Using the ADF

1. Press [Facsimile]

DBH012

2. Make sure "Ready" appears on the screen

100%
set original, specify dest.
= Tt1.0

[ Marual | T¥ Mode

3. Place the originals into the ADF

For details about how to place originals, see "Placing Originals in the Auto Document Feeder",

Paper Specifications and Adding Paper@.

For details about how to place originals to send using the facsimile function, see "Placing Originals

to Send", Fax®.
4. Configure scan settings
For details, see "Specifying Scan Settings", Fax®.
5. Specify a destination
If you make a mistake, press the [Clear/Stop] key, and then enter again.
For details about specifying a destination, see "Specifying a Destination", Fax®.

6. When sending the same original to several destinations (broadcasting), specify the next
destination

If you want to specify another destination manually right after specifying a destination manually,

press [Add Dest].
7. Press [Start]
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Basic Procedure for Transmissions (Memory Transmission)

Sending Originals Using the Exposure Glass

1. Press [Facsimile]

DBH012

2. Make sure "Ready" appears on the screen

100%
set original, specify dest.
= Tt1.0

[ Marual | T¥ Mode

3. Place the first page of the original face down on the exposure glass

For details about the originals you can set, see "Placing Originals on the Exposure Glass", Paper

Specifications and Adding Poper@.

For details about how to place originals to send using the facsimile function, see "Placing Originals

to Send", Fax®.
4. Configure scan settings
For details, see "Specifying Scan Settings", Fax®.
5. Specify a destination
If you make a mistake, press the [Clear/Stop] key, and then enter again.
For details about specifying a destination, see "Specifying a Destination", Fax®.

6. When sending the same original to several destinations (broadcasting), specify the next
destination

If you want to specify another destination manually right after specifying a destination manually,

press [Add Dest].
7. Press [Start]

8. Place the next original on the exposure glass within 60 seconds when you send multiple
originals P Press [Start]
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9. When all originals are scanned, press [#]

DBH089

" The machine dials the destination and starts transmission.

Registering a Fax Destination

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

Pause/ On Hook
Redial Dial

DBH020

1. Select [Address Book Management] P Press [OK]
2. Select [Program/Change] P Press [OK]

3. Enter the registration number you want to register using the number keys or the Quick
Dial keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, display list, registration number, fax destination, e-mail address,
or folder name.

Press [OK]

Press [Details]

Select [Fax Settings] P Press [OK]

Enter the fax number using the number keys P Press [OK]
Press [End]

® N o o »
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Basic Procedure for Transmissions (Memory Transmission)

9. Press [OK]

Deleting a Fax Destination

This section describes how to delete a registered fax destination.

* If you delete a destination that is a specified delivery destination, messages to its registered
Personal Box, for example, cannot be delivered. Be sure to check the settings in the fax function
before delefing any destinations.

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

1. Select [Address Book Management] P Press [OK]
2. Select [Program/Change] P Press [OK]

3. Enter the registration number you want to delete using the number keys or the Quick Dial
keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, destination list, registration number, fax number, e-mail address,
or folder destination.

Press [OK]
Press [Details]
Select [Fax Settings] P Press [OK]

N o v >

Press [Clear/Stop] to delete the fax number

DBH022

8. Press [OK]
9. Press [End]
10. Press [OK]
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Canceling a Transmission

This section explains how to cancel a fax transmission.

Canceling a Transmission Before the Original Is Scanned

Use this procedure to cancel a transmission before pressing the [Start] key.

1. Press [Reset]

DBHO19

Canceling a Transmission While the Original Is Being Scanned

Use this procedure to cancel scanning or transmitting of the original while it is being scanned.

1. Press [Clear/Stop]

DBH022

Canceling a Transmission After the Original Is Scanned (While a Transmission
Is in Progress)

Use this procedure to delete a file that is being sent after the original is scanned.

54



Canceling a Transmission

Press the [Clear/Stop] key, and then select the setting items using the [ ] or [* ] key.

DBH022

1. Select the file you want to cancel » Press [Stop TX]
2. Press [Delete]

3. Press [Escapel]

Pause/ OnH
Redial Dial

Canceling a Transmission After the Original Is Scanned (Before a Transmission
Is Started)

Use this procedure to delete a file stored in memory before its transmission has started.

Press the [Job Information] key, and then select the setting items using the [¥ ] or [4 ] key.

g o Bl o

Job
= Information L]

VWX

= YY) Detail
=] Destination ® Standard @ G5

._ Check comeoo

A Rt (EEREEN
DBH003
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Select [Check/Stop TX File] » Press [OK]
Select the file you want to cancel » Press [Stop TX]
Press [Delete]

Press [Escape] twice

Pause/ OnH
Redial Dial




Printing the Journal Manually

Printing the Journal Manually

You can print the Journal manually.

Press the [Job Information] key, and then select the setting items using the [¥ ] or [4 ] key.

Ei-> olEl/: o °

Job
= Information L]

© o o @ '
BSE

Destination @ Standard @

1o J

A Mot fhos (EEREEN
DBH003

1. Select [Print Journal] » Press [OK]
2. Press [Start]

To cancel printing after pressing the [Start] key, press the [Clear/Stop] key.
3. Press [Escape]

Pause/ OnH
Redial Dial
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5. Print

|
This chapter describes frequently used printer functions and operations. For the information not included
in this chapter, see Print@ on the supplied CD-ROM.

Quick Install for USB

You can install the printer drivers easily from the CD-ROM provided with this machine.

Using USB Quick Install, the PCL 6 printer driver is installed for use with a USB connection with the
printer.

* Manage Printers permission is required fo install the drivers. Log on as an Administrators group
member.

1. Click [USB Quick Install] on the installer screen.

2. The software license agreement appears in the [License Agreement] dialog box. After
reading the agreement, click [I accept the agreement.], and then click [Next].

3. Select the method to install a printer driver, and then click [Next].
4. Select the machine model you want to use, and then click [Next].

5. Make sure the machine is turned off and not connected to the computer, and then click
[Next].

Wait for a moment until file copying is complete.

6. Connect the machine and the computer with a USB cable, and then turn on the machine.
The auto-detecting starts.
To cancel the auto-detecting, click [Stop Auto-detecting].

7. Inthe confirmation dialog box, select [Yes] if you want to use the machine as your default
printer.

8. Click [Finish].

When you are prompted to restart your computer, restart it by following the instructions that

appear.

9. Click [Exit] in the first window of the installer, and then take out the CD-ROM.
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Quick Install for Network

You can install the printer drivers easily from the CD-ROM provided with this machine.

Using Network Quick Install, the PCL 6 printer driver is installed under network environment, and the

Standard TCP/IP port will be set.

N o o >

Manage Printers permission is required to install the drivers. Log on as an Administrators group

member.

. Click [Network Quick Install] on the installer screen.

. The software license agreement appears in the [License Agreement] dialog box. After

reading the agreement, click [l accept the agreement.], and then click [Next].

After confirming you are ready to connect to the printer network, click [Next] in the
[Confirm Network Connection] dialog box.

Select the machine model you want to use in the [Select Printer] dialog box.
Click [Install].

Configure the user code, default printer, and shared printer as necessary.
Click [Continue].

The installation starts.

If the [User Account Control] dialog box appears, and then click [Yes] or [Continue].
Click [Finish].

When you are prompted to restart your computer, restart it by following the instructions that
appear.

Click [Exit] in the first window of the installer, and then take out the CD-ROM.



Displaying the Printer Driver Properties

Displaying the Printer Driver Properties

This section explains how to open the printer driver properties from [Devices and Printers].

* Manage Printers permission is required to change the printer settings. Log on as an Administrators
group member.

* You cannot change the machine default settings for individual users. Settings made in the printer
properties dialog box are applied to all users.

1. On the [Start] menu, click [Devices and Printers].

2. Right-click the icon of the printer you want to use.

3. Click [Printer properties].
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Standard Printing

* The default setting is duplex printing. If you want to print on only one side, select [Off] for the

duplex setting.

* If you send a print job via USB 2.0 while the machine is in Sleep mode, an error message might

appear when the print job is complete. In this case, check if the document was printed.

When Using the PCL 6 Printer Driver

N o 0o MWD

. Click the WordPad menu button in the upper left corner of the window, and then click

[Print].

In the [Select Printer] list, select the printer you want to use.

Click [Preferences].

In the "Job Type:" list, select [Normal Print].

In the "Document Size:" list, select the size of the original to be printed.

In the "Orientation:" list, select [Portrait] or [Landscape] as the orientation of the original.

In the "Input Tray:" list, select the paper tray that contains the paper you want to print
onto.

If you select [Auto Tray Select] in the "Input Tray:" list, the source tray is automatically selected
according to the paper size and type specified.

. Inthe "Paper Type:" list, select the type of paper that is loaded in the paper tray.

. If you want to print multiple copies, specify a number of sets in the "Copies:" box.
10.
11.

Click [OK].

Start printing from the application's [Print] dialog box.



6. Scan

|
This chapter describes frequently used scanner functions and operations. For the information not

included in this chapter, see Scan@ on the supplied CD-ROM.

Basic Procedure for Using Scan to Folder
oy mportant )

* Before performing this procedure, refer to "Preparing to Send by Scan to Folder", Scan® and
confirm the details of the destination computer. Also refer to "Registering Folders", Connecting the

Machine/ System Seﬂings@, and register the address of the destination computer to the address
book.

1. Press [Scanner]

Fax Received  Comn

2. Make sure that no previous settings remain
If a previous setting remains, press the [Reset] key.

3. If the E-mail screen is displayed, press [ 42/ ] to switch to the Scan to Folder screen
OReady

Zet orizinal, specify dest.

I
&/ | Dest.: | Options

Place originals

If necessary, specify scan settings according to the original you want to scan

Specify the destination

N o o >

Press [Start]
* When scanning from the exposure glass

If you are scanning only one original, press the [#] key to send the scan file.
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If you are scanning multiple originals, place them on the machine, and then press the [Start]

key.
Repeat this step until all originals are scanned, and then press the [H] key.
* When scanning from the ADF

Transmission starts immediately after originals are scanned.

Using Scan to Folder in the Windows Environment

The following procedures explain how to create a shared folder on a computer running Windows, and
how to confirm the computer's information. In these examples, Windows 7 Ultimate is the operating

system, and the computer is a member in a network domain. Write down the confirmed information.

Step 1: Confirming the user name and computer name

Confirm the user name and the name of the computer you will send scanned documents to.
1. On the [Start] menu, point to [All Programs], then [Accessories], and then click on
[Command Prompt]
2. Enter the command "ipconfig/all", and then press the [Enter] key
3. Confirm the name of the computer
The computer's name is displayed under [Host Name].

You can also confirm the IPv4 address. The address displayed under [IPv4 Address] is the IPv4
address of the computer.

4. Next, enter the command "set user”, and then press the [Enter] key (Be sure to put a
space between "set" and "user"

5. Confirm the user name

The user name is displayed under [USERNAME].

Step 2: Creating a shared folder on a computer running Microsoft Windows

Create a shared destination folder in Windows and enable sharing. In the following procedure, a
computer which is running under Windows 7 Ultimate and participating in a domain is used as an

example.

* You must log in as an Administrators group member to create a shared folder.

e If "Everyone" is left selected in step 6, the created shared folder will be accessible by all users. This
is a security risk, so we recommend that you give access rights only to specific users. Use the
following procedure to remove "Everyone" and specify user access rights.



Basic Procedure for Using Scan to Folder

. Create a folder, just as you would create a normal folder, in a location of your choice on

the computer

. Right-click the folder, and then click [Properties]

3. On the [Sharing] tab, select [Advanced Sharing...]

11.

13.

© 0 ® N o u »

When using Windows XP, on the [Sharing] tab, select [Share this folder].

Proceed to step 5.

Select the [Share this folder] check box

Click [Permissions]

In the [Group or user names:] list, select "Everyone", and then click [Remove]
Click [Add...]

In the [Select Users or Groups] window, click [Advanced...]

Specify one or more object types, select a location, and then click [Find Now]

From the list of results, select the groups and users you want to grant access to, and then
click [OK]

In the [Select Users or Groups] window, click [OK]

. Inthe [Group or user names:] list, select a group or user, and then, in the [Allow] column

of the permissions list, select either the [Full Control] or [Change] check box

Configure the access permissions for each group and user.

Click [OK]

Step 3: Specifying access privileges for the created shared folder

If you want to specify access privileges for the created folder to allow other users or groups to access

the folder, configure the folder as follows:

1.
2.

S G

N

Right-click the folder created in step 2, and then click [Properties]

On the [Security] tab, select [Edlit...]

When using Windows XP, skip this step.

Click [Add...]

In the [Select Users or Groups] window, click [Advanced...]

Specify one or more object types, select a location, and then click [Find Now]

From the list of results, select the groups and users you want to grant access to, and then
click [OK]

In the [Select Users or Groups] window, click [OK]

8. Inthe [Group or user names:] list, select a group or user, and then, in the [Allow] column

of the permissions list, select either the [Full Control] or [Modify] check box
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9. Press [OK] twice

Registering an SMB Folder

This section describes how to register an SMB folder.

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

Pause/ On Hook
Redial Dial

DBH020

1. Select [Address Book Management] » Press [OK]
2. Select [Program/Change] P Press [OK]

3. Enter the registration number you want to register using the number keys or the Quick
Dial keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, destination list, registration number, fax number, e-mail address,
or folder destination.

4. Press [OK]

5. Press [Details]

6. Select [Auth. Info] » Press [OK]

7. Select [Folder Authentication] » Press [OK]

8. Select [Specify Other Auth. Info] » Press [User]

9. Enter the login user name P Press [OK]

0. Press [Password]

11. Enter the password » Press [OK]

12. Enter the password again to confirm » Press [OK]
13. Press [OK]



Basic Procedure for Using Scan to Folder

14. Press [Escape]

Pause/ OnH
Redial Dial

15. Select [Folder Info] » Press [OK]
16. Select [SMB] P Press [OK]
17. Select [Manual Entry] or [Browse Network] P Press [OK]

To specify a folder, you can either enter the path manually or locate the folder by browsing the
network.

18. Press [Com.Test] to check the path is set correctly. u

Locating the SMB folder manually

This section describes how to locate the SMB folder manually.

1. Press [Manual Entry] » Press [OK]
2. Enter the path P Press [OK]

If the format of the entered path is not correct, a message appears. Press [Exit], and then enter the

path again.

Locating the SMB folder using Browse Network

This section describes how to locate the SMB folder using Browse Network.

1. Select [Browse Network] P Press [OK]
2. Select a work group » Press [OK]
The client computers sharing the same network as the machine appear.
Network display only lists client computers you are authorized to access.
3. Select a client computer P Press [OK]
Shared folders under it appear.
You can press [Up] to switch between levels.

4. Select the folder you want to register » Press [Apply]
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6. Scan

5.

Press [OK]

Deleting an SMB Registered Folder

This section describes how to delete the registered SMB folder.

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

1.
2.
3.

V0 © N O U0 b

10.

Select [Address Book Management] P Press [OK]
Select [Program/Change] P Press [OK]

Enter the registration number you want to delete using the number keys or the Quick Dial
keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, destination list, registration number, fax number, e-mail address,
or folder destination.

. Press [OK]

. Press [Details]

. Select [Folder Info] P Press [OK]

. Select the protocol which is not currently selected P Press [OK]
. Press[Yes]

. Press [Escape]

Pause/ OnH
Redial Dial

Press [End]

Specifying a Folder Path by Entering it Manually

Press [Dest.:], and then select the setting items using the [Y ] or [4 ] key.

1.

Select [SMB] P Press [OK]

2. Select [Manual Entry] » Press [OK]
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Basic Procedure for Using Scan to Folder

. Enter the path for the folder P Press [OK]

In the following example path, the shared folder name is "user" and the computer name is

"deskO1":
\\desk01\user

. Depending on the destination setting, enter the user name for logging in to the computer
P Press [OK]

. Depending on the destination setting, enter the password for logging in to the computer »
Press [OK]

. Press [Com.Test]
A connection test is performed to check whether the specified shared folder exists.

If the message "Connection to PC failed. Check the settings." appears, see page 110 "Messages
Displayed When Using the Scanner Function".

7. Check the connection test result » Press [Exit]

8. Press [OK]
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Basic Procedure for Sending Scan Files by E-
mail

N o v &

. Press [Scanner]

Fax Received  Comn

DBH013

. Make sure that no previous settings remain

If a previous setting remains, press the [Reset] key.

. Ifthe Scan to Folder screen is displayed, press [/ ] to switch to the E-mail screen

OReady
set original, specify dest.

&

&/3 | Wanual | Options

Place originals
If necessary, specify scan settings according to the original you want to scan
Specify the destination
Press [Start]
* When scanning from the exposure glass
If you are scanning only one original, press the [#] key to send the scan file.

If you are scanning multiple originals, place them on the machine, and then press the [Start]
key.

Repeat this step until all originals are scanned, and then press the [H] key.
* When scanning from the ADF

Transmission starts immediately after originals are scanned.



Basic Procedure for Sending Scan Files by E-mail

Registering an E-mail Destination

This section describes how to register an e-mail destination.

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

Pause/ On Hook
Redial Dial

DBH020

. Select [Address Book Management] » Press [OK]

2. Select [Program/Change] P Press [OK]

¥ © N o> U &

. Enter the registration number you want to register using the number keys or the Quick

Dial keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, destination list, registration number, fax number, e-mail address,
or folder destination.

Press [OK]

Press [Details]

Select [E-mail Settings] P Press [OK]

Enter the e-mail address using the number keys and the Quick Dial keys P Press [OK]
Press [End]

Press [OK]

Deleting an E-mail Destination

Press the [User Tools] key, and then select the setting items using the [¥] or [4] key.

1.
2.

Select [Address Book Management] P Press [OK]
Select [Program/Change] P Press [OK]
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6. Scan

3. Enter the registration number you want to delete using the number keys or the Quick Dial
keys P Press [OK]

You can automatically specify registration numbers 001 - 032 by pressing the Quick Dial key.
Press [Search] to specify by name, destination list, registration number, fax number, e-mail address,
or folder destination.

Press [OK]
Press [Details]

. Select [E-mail Settings] P Press [OK]

4,
5.
6
7

. Press [Clear/Stop] to delete the mail address

DBH022

8. Press [OK]
9. Press [End]
10. Press [OK]

Specifying an E-mail Address by Entering It Manually

1. Press [Manual]
2. Enter the e-mail address P Press [OK]
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Specifying Send Options

Specifying Send Options

Resolution

Select resolution for scanning originals.
Select [100dpi], [200dpi], [300dpi], [400dpi], or [600dpi] as the scanning resolution.

Press [Options] , and then select the setting items using the [Y ] or [4 ] key.

—

. Select [Send Options] P Press [OK]
2. Select [Resolution] P Press [OK]

3. Select a resolution » Press [OK]

4. Press [Escape] twice

Pause/ OnH
Redial Dial

Original Orientation

This section explains how to correctly display the top/bottom orientation of scanned originals on a client
computer screen.

Press [Options], and then select the setting items using the [Y ] or [4 ] key.
1. Select [Send Options] P Press [OK]

Select [Original Orientation] P Press [OK]
Select [RIB]] or [E®] to specify the same orientation as that of the original » Press [OK]

A @0 N

Press [Escape] twice
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6. Scan

Original Setting

This section explains how to specify the page opening orientation and whether both sides of the original

are scanned.

e This function is available for SP 36 10SF only.

Press [Options], and then select the setting items using [Y ] or [4 ] key.

1.

Select [Send Options] P Press [OK]

2. Select [Original Setting] P Press [OK]

3. Select [1 Sided Original], [2 Sided Orig.(T to TEHE)] or [2 Sided Orig.(T to BEE)] » Press
[OK]
Binding orientation and required page opening orientation
Binding orientation Page opening orientation
2 Sided Orig.(T to TE)
= 2 Sided Orig.(T to BEH)
4. Press [Escape] twice
Scan Size

Select the size of the original to be scanned.

You can select from template sizes. For details about available sizes, see "Scan Settings", Scan®.

Press [Options], and then select the setting items using the [Y ] or [4 ] key.

1.

A @0 N

Select [Send Options] P Press [OK]
Select [Scan Size] P Press [OK]
Select the scan size » Press [OK]

Press [Escape] twice

File Type

This section explains the procedure for specifying the file type of a file you want to send.

You can select one of the following file types:
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Specifying Send Options

* [Single Page:TIFF/JPEG], [Single Page:PDF]

If you select a single-page file type when scanning multiple originals, one file is created for single
page and the number of files sent is the same as the number of pages scanned.

* [Multi-page:PDF]

If you select a multi-page file type when scanning multiple originals, scanned pages are combined
and sent as a single file.

Selectable file types differ depending on the scan settings and other conditions. For details about file
types, see "Notes and limitations of file types", Scan@®.

Press [Options], and then select the setting items using the [Y ] or [4 ] key.
1. Select [Send Options] P Press [OK]

Select [File Type] » Press [OK]
Select the file type P Press [OK]

A @ N

Press [Escape] twice
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7. Web Image Monitor

This chapter describes frequently used Web Image Monitor functions and operations. For the
information not included in this chapter, see Connecting the Machine/ System Setﬁngs@ on the
supplied CD-ROM or Web Image Monitor Help.

Displaying the Top Page

There are two modes available with Web Image Monitor: guest mode and administrator mode.
Displayed items may differ depending on the machine type.
Guest mode

This mode requires no login to enter.

In the guest mode, the machine status, settings, and print job status can be viewed, but the machine
settings cannot be changed.

Administrator mode
This mode requires an administrator login to enter.
In the administrator mode, you can configure various machine settings.

* When entering an IPv4 address, do not begin segments with zeros. For example: If the address is
"192.168.001.010", you must enter itas "192.168.1.10".

1. Start your Web browser.

2. Enter "hitp://(machine's IP address or host name)/" in your Web browser's address bar.
The top page of Web Image Monitor appears.
If the machine's host name has been registered on the DNS or WINS server, you can enter it.

When setting SSL, a protocol for encrypted communication, under the environment in which server
authentication is issued, enter "https://(machine's IP address or host name)/".

3. To log in to Web Image Monitor in the administrator mode, click [Login] on the top page.
The window for entering the login user name and password appears.

4. Enter your login user name and password, and then click [Login].
For details about the login user name and password, contact your administrator.

Depending on the configuration of your Web browser, the login user name and password might be
saved. If you do not want to save them, configure your Web browser's settings so that this
information is not saved.
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7. Web Image Monitor

Web image monitor
Hom
conds (@) Refresh == 4
FAQs/Knowledge Base
status
a status ®) Ready e
= Toner Tray 1 ]
o = 100 Plinpaper? e [
Plin Paper 2
 Toner Cartidge Gy
Intema Tray
Capacity LJ Status OK

DBH225

. Menu area

Displays the content of a selected menu item.
Header area

Displays the dialog box for switching to the user mode and administrator mode and the menu for each mode.
Also displays the link to Help.

Help

Clicking the Help button (M) in the header area displays the contents of Help.

Clicking the Help button (@) in the work area displays the Help for the setting items in the work area.
An internet connection is required to view the contents of Help.

Refresh

Click () at the upper right in the work area to update the machine information. Click the Web browser's
[Refresh] button to refresh the entire browser screen.

FAQs/Knowledge Base

Click Bl 1o view the Frequently Asked Questions. An internet connection is required to view the Frequently
Asked Questions.

Basic Information area

Displays the basic information of the machine.

. Work area

Displays the contents of the item selected in the menu area



8. Adding Paper and Toner

This chapter describes how to load paper into the paper tray and recommended paper sizes and types.

Loading Paper into Paper Trays

Every paper tray is loaded in the same way.

In the following example procedure, paper is loaded into Tray 1.

* Be sure fo select the correct paper size and feed direction using the paper size dial on the tray.
Otherwise, the machine might be damaged, or printing problems might occur.

* Do not mix different types of paper in the same paper tray.

* Make sure the paper stack does not exceed the upper limit mark inside the paper tray. Excessive

stacking can cause paper jams.

* After loading paper, specify the paper size using the control panel or paper size dial, and paper
type using the control panel. When printing a document, specify the same paper size and type in
the printer driver as specified on the machine.

* Ifyou load paper whose size is not indicated on the paper size dial, you can specify the paper size
in [Tray Paper Settings]. For details, see “Changing Paper Size Settings”, Paper Specifications and
Adding Poper@.

* Do not move the side paper guides and end guide forcefully. Doing so may damage the tray. u

¢ When loading a low number of sheets, be sure not to squeeze the side paper guides and end
guide in too tightly. If the side paper guides and end guide are squeezed too tightly against the
paper, the edges may crease or the paper may misfeed.

* When loading label paper, load it one by one.

* The envelope lever is kept down by the factory default. Before printing with paper, except for
envelopes, be sure fo raise the envelope lever all the way up.

DBH076
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8. Adding Paper and Toner

1. Check that paper in the paper tray is not being used, and then pull out the paper tray
carefully. Adjust the paper size dial to match the size and feed direction of the paper in
the paper tray.

DBHO053

2. Pull the tray carefully until it stops, lift the front side of the tray, and then pull it out of the
machine.

DBH054

Place the tray on a flat surface.

3. Pinch the clip on the side paper guide and slide it to match the paper size.

CXC613
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Loading Paper into Paper Trays

4. Pinch the end guide and slide it inward to match the standard size.

CXC614

5. Fan the paper before loading it in the tray.

CBK254

6. Load the new paper stack print side down. u

Make sure paper is not stacked higher than the upper limit (upper line) marked inside the tray.

CXC666
7. Adjust the paper guides to close any gaps.
Do not move paper loaded in the tray more than a few millimeters.

Moving the loaded paper excessively can cause damage to paper edges on the openings of the
tray's lifting plate, resulting in sheets being folded or becoming jammed.
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8. Lift the front side of the tray, and then slide it into the machine carefully until it stops.

DBH055

To avoid paper jams, make sure the tray is securely inserted.

* When loading paper larger than A4l or 81/, x 110 into Tray 1, extend the tray. For details, see
"Extending Tray 1", Paper Specifications and Adding Paper@.

* letterhead paper must be loaded in a specific orientation. For details, see page 87 "Loading
Orientation-fixed Paper or Two-sided Paper".

* You can load envelopes into Tray 1. For details about loading envelopes, see "Loading
Envelopes", Paper Specifications and Adding Paper@.



Loading Paper into the Bypass Tray

Loading Paper into the Bypass Tray

Use the bypass tray to use OHP transparencies and paper that cannot be loaded in the paper trays.

* The maximum number of sheets you can load at the same time depends on paper type. Do not
stack paper over the limit mark. For the maximum number of sheets you can load, see page 88
"Recommended Paper Sizes and Types".

Do not mix different types of paper.

e After loading paper, specify the paper size and type using the control panel. When printing a
document, specify the same paper size and type in the printer driver as specified on the machine.

e When loading label paper, load it one by one.

1. While pressing and holding the button in the upper center of the bypass tray, pull the tray
open.

DBH066

Pull the extender out when loading paper larger than A4l2 or 81/, x 110,

DBH077
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8. Adding Paper and Toner

2. Slide both sides of the paper guide outward, and then load paper print side up until it
stops.

DBH078

3. Adjust both sides of the paper guide to match the paper width.

DBH079

* When using the bypass tray, it is recommended that you set the paper direction to [,
* When loading thick paper or OHP transparencies, specify the paper size and the paper type.

* Lletterhead paper must be loaded in a specific orientation. For details, see page 87 "Loading
Orientation-fixed Paper or Two-sided Paper".

* You can load envelopes into the bypass tray. For details about loading envelopes, see "Loading
Envelopes", Paper Specifications and Adding Paper@.

* When copying from the bypass tray, see "Copying from the Bypass Tray", Copy@‘ When printing
from a computer, see page 85 "Printing from the Bypass Tray Using the Printer Function".

* When the [Panel Key Sound] is turned off, it does not sound if you load paper into the bypass tray.
For details about [Panel Key Sound], see "System Settings", Connecting the Machine/ System
Settings@.
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Loading Paper into the Bypass Tray

Printing from the Bypass Tray Using the Printer Function

¢ Ifyou select [Machine Setting(s)] in [Bypass Tray] under [Tray Setting Priority] in [System] of the
[Printer Features] menu, the settings made using the control panel have priority over the printer

driver settings. For details, see "System", Print®.

e The default of [Bypass Tray] is [Driver/Command].
* Settings remain valid until they are changed.
* For details about setting printer drivers, see "Printing Documents", Print®.
o {Region A (mainly Europe and Asia)

* [A4D] s the default setting for [Printer Bypass Paper Size].
o {Region B (mainly North America)

o [81/5x 110 is the default setting for [Printer Bypass Paper Size].

Specifying regular sizes using the control panel

Press the [User Tools] key, and then select the setting items using the [Y ] or [+ ] key.

1. Select [Tray Paper Settings] P Press [OK]
2. Select [Printer Bypass Paper Size] P Press [OK]

3. Select the paper size » Press [OK]

Specifying a custom size paper using the control panel

Press the [User Tools] key, and then select the sefting items using the [Y ] or [4 ] key.

1. Select [Tray Paper Settings] P Press [OK]
Select [Printer Bypass Paper Size] P Press [OK]
Select [Custom Size] P Press [OK]

Enter the horizontal value » Press [OK]

o » 0N

Enter the vertical value » Press [OK]

85



8. Adding Paper and Toner

Specifying thick paper or OHP transparencies for paper type using the control panel

* Usually only one side of OHP transparencies can be used for printing. Be sure to load them with the

print side up.
* When printing onto OHP transparencies, remove printed sheets one by one.

Press the [User Tools] key, and then select the sefting items using the [Y ] or [4 ] key.

1. Select [Tray Paper Settings] » Press OK
Select [Paper Type: Bypass Tray] P Press [OK]
Select the type of the paper set in bypass tray P Press [OK]

A 0N

If you have selected [Recycled Paper], [Color Paper], [Letterhead], [Label Paper],
[Envelopel, or [Preprinted Paper] for the paper type, press [Escape]

Pause/ OnH
Redial Dial

. Select [Maintenance] P Press [OK]

5
6. Select the paper thickness setting for the specified paper type » Press [OK]
7. Select the tray where the specified type of paper is loaded » Press [OK]

8

. Select the paper thickness » Press [OK]

* For details about paper thickness, see "System Settings", Connecting the Machine/ System Settings

.
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Loading Orientation-fixed Paper or Two-sided Paper

Loading Orientation-fixed Paper or Two-sided
Paper
Orientation-fixed (top to bottom) or two-sided paper (for example, letterhead paper, punched paper, or

copied paper) might not be printed correctly, depending on how the originals and paper are placed.

Settings for the User Tools
Specify [Auto Detect] for [Letterhead Setting] in [System] under the [Printer Features] menu, and
then place the paper as shown below.

For details about the letterhead settings, see "Printer Features", Print®.

Print side Paper trays Bypass tray
One-sided -_—
1
Two-sided -
1

* To print on letterhead paper when [Auto Detect] is specified for [Letterhead Setting], you must
specify [Letterhead] as the paper type in the printer driver's settings.

* For details about how to make two-sided prints, see "Printing on Both Sides of Sheets", Print®.
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8. Adding Paper and Toner

Recommended Paper Sizes and Types

This section describes recommended paper sizes and types.

* If you use paper that curls, either because it is too dry or too damp, a paper jam may occur.

* Do not use paper designed for inkjet printers, as these may stick to the fusing unit and cause a

misfeed.

* When you load OHP transparencies, check the front and back of the sheets, and place them

correctly, or a misfeed might occur.

Tray 1

90 lb. Index)
Thin Paper-Thick Paper 2

@ Region A\ (mainly Europe and
Asia)

Vertical: 148.0-356.0 mm
Horizontal: 100.0-216.0 mm
@Region B (mainly North America)
Vertical: 5.83-14.01 inches
Horizontal: 3.94-8.50 inches

Paper type and weight Paper size Paper capacity
52-162 g/m? (14 1b. Bond- | Select the paper size using the 250 sheets
90 Ib. Index) paper size dial on the tray " 1:

Thin Paper—Thick Paper 2 A4l AsD) Asld, 81/, x 14D,
81/, x 11D, 51/, x 81/,1
52-162 g/m? (14 1b. Bond— | Setthe paper size dial on the tray to | 250 sheets
90 Ib. Index) "¥" and select the paper size with
Thin Paper-Thick Paper 2 the control panel.
A5, B5 JISD), B6 JISL, 81/, x 13
D, 81/,% 14D, 81/,x13D,
8x 130, 8x101/,0), 8 x 100,
71/4x 101 /50, 16KD
52-162 g/m2 (14 lb. Bond- | Custom size: 250 sheets

Envelopes

Select the paper size:

41/gx91/,0,37/x71/,00, C5
EnvD, Cé EnvD, DL EnvlY

*2




Recommended Paper Sizes and Types

*1 When a print job is performed on A5 or 5 1/," X 8 1/," paper, it is recommended to set the paper
horizontally. While a print job is performed on paper that is loaded vertically, smearing may occur near
the edges of the printed paper. Also, use the bypass tray when printing on paper that is set horizontally.

*2 Do not stack over the limit mark. The number of sheets you can load in the paper tray varies depending
on the weight and condition of the paper.

Lower paper tray (250 sheets)

Paper type and weight Paper size Paper capacity
52-162 g/m? (14 1b. Bond- | Select the paper size using the 250 sheets
90 Ib. Index) paper size dial on the tray " 1:

Thin Paper—Thick Paper 2 A4l AsD) A6l 81/, x 14D,
81/,x 110,51/, x 81/,
52-162 g/m? (14 |b. Bond— | Setthe paper size dial on the tray to | 250 sheets
90 Ib. Index) "¥" and select the paper size with
Thin Paper-Thick Paper 2 the control panel:
A5, B5 JISD), B6 JIsD, 81/, x 13
U, 81/,x 14D, 81/, 13D,
8x 130, 8x101/,0), 8 x 100,
71/4%x 101 /50, 16KD
52-162 g/m? (14 |b. Bond— | Custom size: 250 sheets
90 Ib. Index) @Region A\ (mainly Europe and
Thin Paper-Thick Paper 2 Asia)
Vertical: 148.0-356.0 mm
Horizontal: 100.0-216.0 mm
@D Region B (mainly North America)
Vertical: 5.83-14.01 inches
Horizontal: 3.94-8.50 inches
Lower paper tray (500 sheets)

Paper type and weight Paper size Paper capacity

52-162 g/m2 (14 lb. Bond- | Select the paper size using the 500 sheets

90 lb. Index)
Thin Paper-Thick Paper 2

paper size dial on the tray " 1:

A4D, AsD A6LD), 81/, x 140,
81/ x 11D, 51/, x 81/,0
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Paper type and weight Paper size Paper capacity
52-162 g/m2 (14 |b. Bond— | Setthe paper size dial on the tray to | 500 sheets
90 Ib. Index) "¥" and select the paper size with
Thin Paper-Thick Paper 2 the control panel.
A5, B5 JISD), B6 JISD, 81/, x 13
L, 81/,x 14D, 8'/,x13D,
8x 130, 8x101/,07, 8 x 100,
71/4%x 101 /50, 16K
52-162 g/m2 (14 lb. Bond- | Custom size: 500 sheets
90 Ib. Index] @) Region A\ (mainly Europe and
Thin Paper-Thick Paper 2 Asia)
Vertical: 148.0-356.0 mm
Horizontal: 100.0-216.0 mm
@ Region B (mainly North America)
Vertical: 5.83-14.01 inches
Horizontal: 3.94-8.50 inches
Bypass tray
Paper type and weight Paper size Paper capacity
52-162 g/m? (141b. Bond- | Select the paper size 1" 2: ¢ Thin Paper—Plain
Thin Paper-Thick Paper 2 DD, 81/,x 140, 81/, x 130, sheets
8'/2x 11D, 81/,x 14D, * Middle Thick-

81/,x 130, 8x 130 8x101/,
D 8x100,71/,x101/,0, 51/,
x 81/,03, 16KD

Thick Paper 2: *3

52-162 g/m? (14 Ib. Bond-
90 Ib. Index)

Thin Paper-Thick Paper 2

Custom size 4

@} Region A\ (mainly Europe and
Asia)

Vertical: 127.0-900.0 mm
Horizontal: 60.0-216.0 mm

@ Region B (mainly North America)
Vertical: 5.00-35.43 inches
Horizontal: 2.37-8.50 inches

e Thin Paper-Plain
Paper 2: 100
sheets

e Middle Thick-
Thick Paper 2: "3




Recommended Paper Sizes and Types

Paper type and weight Paper size Paper capacity

OHP transparencies Select the paper size 1 "2: *5

A4 AsDD, A6, B5 JISD, B6 IS
U=, 81/, x 140, 81/, x 130,
81/, x 110, 81/4x 140,

8l/,x 130, 8x 130, 8x101/,
U gx 100, 71/,x101/50, 51/,
x 81/,0003, 16K

Custom size 4:

Label paper (adhesive labels) 1 sheet

@ Region A (mainly Europe and
Asia)

Vertical: 127.0-900.0 mm
Horizontal: 60.0-216.0 mm
@Region B (mainly North America)
Vertical: 5.00-35.43 inches
Horizontal: 2.37-8.50 inches

Envelopes Select the paper size: "6

41/gx91/,0,37/gx71/,0, C5
EnvD), C6 EnvD, DL EnvDY

*1 When a print job is performed on A5 or 5 1/," x 8 1/," paper, it is recommended to load the paper
horizontally. While a print job is performed on paper that is loaded vertically, smearing may occur near
the edges of the printed paper.

*2 For copier mode, see "Copying onto Regular Size Paper from the Bypass Tray", Copy@. For printer
mode, see page 85 "Specifying regular sizes using the control panel".

*3 When loading thick paper in the bypass tray, do not stack paper over the limit mark. The number of
sheets you can load in the bypass tray varies depending on the weight and condition of the paper.

*4 Enter the paper size. For copier mode, see "Copying onto Custom Size Paper from the Bypass Tray",
Copy@. For printer mode, see page 85 "Specifying a custom size paper using the control panel".

*5 When loading OHP transparencies in the bypass tray, do not stack paper over the limit mark.

*6 Load envelopes so that the height of the stack of envelopes does not exceed the limit mark of the bypass
tray without pressing on the stack of envelopes.

Paper Thickness

Paper Thickness ! Paper weight

Thin Paper 52-65g/m? (14-18 |b. Bond)
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8. Adding Paper and Toner

Paper Thickness ! Paper weight
Plain Paper 66-74 g/m? (18-20 |b. Bond)
Plain Paper 2 75-90 g/m? (20-24 Ib. Bond)
Middle Thick 91-105 g/m?2 (24-28 Ib. Bond)
Thick Paper 1 106-130 g/m? (28-35 Ib. Bond)
Thick Paper 2 131-162 g/m? (35 |b. Bond-90 Ib. Index)

*1 Print quality will decrease if the paper you are using is close to the minimum or maximum weight.
Change the paper weight setting to thinner or thicker.

* Recommended paper: Paper with calcium carbonate (CaCO3) ratio of 15% or less.

e Certain types of paper, such as OHP transparencies, may produce noise when delivered. This

noise does not indicate a problem and print quality is unaffected.

* The paper capacity described in the tables above is an example. Actual paper capacity might be
lower, depending on the paper type.

* When loading paper, make sure the stack height does not exceed the limit mark of the paper tray.

* |f multiple sheet feeding occurs, fan sheets thoroughly or load sheets one by one from the bypass

tray.
* Flatten out curled sheets before loading them.
* Depending on the paper sizes and types, the copy/print speed may be slower than usual.
* When loading envelopes, see "Loading Envelopes", Paper Specifications and Adding Poper@.

* When loading thick paper of 106162 g/m? (28 Ib. Bond-90 Ib. Index), see page 93 "Thick
Paper".

* We recommend that you use specified label paper.
* When loading OHP transparencies:
¢ |f multiple sheet feeding occurs, place one sheet at a time.
¢ When copying onto OHP transparencies, see "Copying onto OHP Transparencies", Copy@.

¢ When printing on OHP transparencies from the computer, see "Specifying thick paper or OHP
transparencies for paper type using the control panel", Paper Specifications and Adding
Pcper@.

* Fan OHP transparencies thoroughly whenever you use them. This prevents OHP
transparencies from sticking together, and from feeding incorrectly.

e Remove copied or printed sheets one by one.



Recommended Paper Sizes and Types

Thick Paper

This section gives you various details about and recommendations concerning thick paper.

When loading thick paper of 106-162 g/m?2 (28 Ib. Bond-90 Ib. Index) in the paper trays or bypass
tray, follow the recommendations below to prevent misfeeds and loss of image quality.

* Jams and misfeeds can occur when printing on thick smooth paper. To prevent such problems, be
sure to fan smooth paper thoroughly before loading them. If paper continues to become jammed or
feed in together even after they are fanned, load them one by one from the bypass tray.

* When loading thick paper, set the paper direction according to its grain, as shown in the following

diagram:

Direction of paper

TR
= M

* Select [Thick Paper 1] or [Thick Paper 2] as the paper thickness in [Tray Paper Settings].

o |f [Thick Paper 2] is selected, the print speed may change.

* Even if thick paper is loaded as described above, normal operations and print quality might still not
be possible, depending on the paper type.

* Prints might have prominent vertical creases.

* Prints might be noticeably curled. Flatten out prints if they are creased or curled.

* When printing onto thick paper, the print speed changes.

Envelopes

This section gives you various details about and recommendations concerning envelopes.

* Do not use window envelopes.
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* Fan the envelopes before loading them to separate them and prevent the glue on them from
causing them to stick together.

* Some kinds of envelope might cause misfeeds, wrinkles or print poorly.
* When loading envelopes in the [ orientation, load them with flaps closed.

¢ Before loading envelopes, press down on them to remove any air from inside, flatten out all four
edges. If they are bent or curled, flatten their leading edges (the edge going into the machine) by
running a pencil or ruler across them.

e When loading envelopes, do not stack paper over the limit mark. If you squeeze exira envelopes
into the bypass tray, misfeeds might occur.

In copier mode

When copying onto envelopes, load them according to the applicable orientation shown below.

How to load envelopes

Orientation of

envelopes Exposure glass Tray 1 Bypass tray
Side-opening
envelopes [/ * L
* Flaps: closed * Flaps: closed
* Bottom side of * Flaps: closed ¢ Bottom side of

envelopes:
toward the front
of the machine

Side to be

Bottom side of
envelopes:
toward the right
of the machine

envelopes:
toward the right
of the machine

Side to be

scanned: face e Side fo be printed: face up

down printed: face

down

When loading envelopes, specify the envelope size and thickness. For details, see "Copying onto

Envelopes", Copy@‘
In printer mode

When printing onto envelopes, load them according to the applicable orientation shown below:



Recommended Paper Sizes and Types

How to load envelopes

Types of envelopes Tray 1 Bypass tray
Side-opening
envelopes [/ }7 L)
¥ i
* Flaps: closed
* Flaps: closed * Bottom side of envelopes:
* Bottom side of envelopes: toward the right of the
toward the right of the machine
machine ¢ Side to be printed: face up

* Side to be printed: face
down

When loading envelopes, select "Envelope" as the paper types using both the User Tools and
printer driver, and specify the thickness of envelopes. For details, see "Printing on Envelopes", Print

.

Recommended envelopes

For information about recommended envelopes, contact your local dealer.

For details about the sizes of envelopes you can load, see page 88 "Recommended Paper Sizes u
and Types".

* load only one size and type of envelope at a time.

* To get better output quality, it is recommended that you set the leading-edge print margin to at least
15 mm (0.6 inches) and the other margins to at least 10 mm (0.4 inches) each.

* Output quality on envelopes may be uneven if parts of an envelope have differing thicknesses. Print

one or two envelopes to check print quality.
* Flatten out prints if they are creased or curled.
* Check the envelopes are not damp.

* High temperature and high humidity conditions can reduce print quality and cause envelopes to

become creased.

* Depending on the environment, copying or printing on envelopes may wrinkle them even if they

are recommended.

e Certain types of envelopes might come out creased, dirtied, or misprinted. If you are printing a
solid color on an envelope, lines may appear where the overlapped edges of the envelope make it
thicker.
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Adding Toner

Refer to the maintenance guide provided with the new items for the replacement.

This section explains precautions when adding toner, how to send faxes or scanned documents when

the toner has run out, and how to dispose of used toner.

AWARNING

Do not incinerate toner (new or used) or toner containers. Doing so risks burns. Toner will ignite

on contact with naked flame.

Do not store toner (new or used) or toner containers anywhere near naked flames. Doing so

risks fire and burns. Toner will ignite on contact with naked flame.

Do not use a vacuum cleaner to remove spilled toner (including used toner). Absorbed toner
may cause a fire or explosion due to electrical contact flickering inside the vacuum cleaner.
However, it is possible to use a vacuum cleaner that is explosion-proof and dust ignition-proof. If
toner is spilled on the floor, remove the spilled toner slowly using a wet cloth, so that the toner is
not scattered.

A\ CAUTION

Do not crush or squeeze toner containers. Doing so can cause toner spillage, possibly resulting
in dirtying of skin, clothing, and floor, and accidental ingestion.

Store toner (new or used), toner containers, and components that have been in contact with

toner out of reach of children.

If toner or used toner is inhaled, gargle with plenty of water and move into a fresh air

environment. Consult a doctor if necessary.

If toner or used toner gets into your eyes, flush immediately with large amounts of water. Consult

a doctor if necessary.

If toner or used toner is swallowed, dilute by drinking a large amount of water. Consult a doctor

if necessary.

When removing jammed paper or replacing toner, avoid getting toner (new or used) on your
clothing. If toner comes into contact with your clothing, wash the stained area with cold water.

Hot water will set the toner into the fabric and make removing the stain impossible.




Adding Toner

/A CAUTION

¢ When removing jammed paper or replacing toner, avoid getting toner (new or used) on your

skin. If toner comes into contact with your skin, wash the affected area thoroughly with soap and
water.

e When replacing a toner or waste toner container or consumables with toner, make sure that the
toner does not splatter. Put the waste consumables in a bag after they are removed. For
consumables with a lid, make sure that the lid is shut.

* Always replace the toner cartridge when a notification appears on the machine.

¢ Fault may occur if you use toner other than the recommended type.
¢ When adding toner, do not turn off the main power. If you do, settings will be lost.

* Store toner where it will not be exposed to direct sunlight, temperatures above 35°C (95°F), or
high humidity.

* Store toner on a flat surface.
* Do not shake the toner cartridge with its mouth down after removing it. Residual toner may scatter.
* Do not repeatedly install and remove toner cartridges. This will result in toner leakage.

Replace the toner cartridge when the following messages appear on the display.

"WAJd toner Replace Toner Cartridge.”

* If"&Toner is almost empty." appears, the toner has almost run out. Have a replacement toner

cartridge at hand.

* If & appears when there is a lot of foner, follow the toner replacement instructions that appear on
the screen: Pull out the cartridge, and then reinstall it.

Sending Faxes or Scanned Documents When Toner Has Run Out

When the machine has run out of toner, the indicator on the display lights. Note that even if there is no
toner left, you can still send faxes or scanned documents.

* If number of communications executed after the toner has run out and not listed in the automatically
output Journal exceeds 100, communication is not possible.

1. Make sure the machine is in facsimile or scanner mode.

2. Press [Exit], and then perform transmission operation.

The error message disappears.
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* Any reports are not printed.

* Ifthe fax or scanner screen does not appear in step 1, press the [Facsimile] key or the [Scanner]
key.

Disposing of Used Toner

This section describes what to do with used toner.
Toner cannot be re-used.

Pack used toner containers in the container's box or a bag to prevent the toner from leaking out of the
container when you dispose of it.

@D Region A\ (mainly Europe and Asia)

If you want to discard your used toner container, please contact your local sales office. If you discard it
by yourself, treat it as general plastic waste material.

@D Region B (mainly North Americal)

Please see our local company website for information on the recycling of supply products, or you can
recycle items according to the requirements of your local municipalities or private recyclers.



9. Troubleshooting

This chapter describes basic troubleshooting procedures.

Indicators

This section describes the indicators displayed when the machine requires the user to remove misfed
paper, to add paper, or to perform other procedures.

Indicator Status

8 . Paper Misfeed indicator Appears when a paper misfeed occurs.

For details about removing jammed paper, see "Removing
Jammed Paper", Troubleshooting@.

2=: Original Misfeed indicator Appears when an original misfeed occurs.

For details about removing jammed paper, see "Removing
Jammed Paper", Troubleshooting@.

& : Load Paper indicator Appears when paper runs out.

For details about loading paper, see "Loading Paper",
Paper Specifications and Adding Paper@.

& : Add Toner indicator Appears when toner runs out.

For details about adding toner, see "Adding Toner",
Maintenance and Specificotions@.

1 - Service Call indicator Appears when the machine is malfunctioning or requires
maintenance.

[ : Cover Open indicator Appears when one or more covers of the machine are

open.
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Panel Tone

The following table describes the meaning of the various beep patterns that the machine produces to

alert users about left originals and other machine conditions.

Beep pattern

Meaning

Causes

Single short beep

Panel/screen input

accepted.

A control panel or screen key was
pressed.

Short, then long beep

Panel/screen input rejected.

An invalid key was pressed on the
control panel or screen, or the entered
password was incorrect.

Single long beep

Job completed successfully.

A Copy Features job has finished.

Two long beeps

Machine has warmed up.

When the power is turned on or the
machine exits Sleep mode, the
machine has fully warmed up and is
ready for use.

Five long beeps repeated
four times.

Soft alert

An original has been left on the

exposure glass or paper tray is empty.

Five short beeps repeated
five times.

Strong alert

The machine requires user attention
because paper has jammed, the toner
needs replenishing, or other problems
have occurred.

* Users cannot mute the machine's beep alerts. When the machine beeps to alert users of a paper

jam or toner request, if the machine's covers are opened and closed repeatedly within a short

space of time, the beep alert might continue, even after normal status has resumed.

* You can select to enable or disable beep alerts. For details about Panel Key Sound, see "General
Features", Connecting the Machine/ System Settings@.
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When You Have Problems Operating the Machine

When You Have Problems Operating the

Machine

This section describes common problems and messages. If other messages appear, follow the

instructions displayed.

Problem

Causes

Solutions

The machine has just been
turned on and the User Tools
screen is displayed, but the
User Tools menu has items

missing.

Functions other than the
copier function are not yet
ready.

Functions appear in the User Tools
menu when they become ready for
use. Time required varies by function.
Wait a little longer.

"Please wait." appears.

This message appears when
the machine is warming up.

* Wait until the message
disappears. Do not turn off the
main power switch while the

message is displayed.

* |f the machine is not ready in five
minutes, turn off the main power
switch and make sure the main
power indicator turns off. Wait at
least ten seconds and then turn
the main power switch on again.
If the machine is still not ready in
five minutes, contact your service

representative.

"Please wait." appears.

The current environmental
condition is outside the
recommended temperature
range for the machine.

* Check the optimum environmental
conditions for the machine and
move it to a different location.

¢ Leave the machine for a while
and allow it o adapt to the
environment.

For details about the optimum
environmental conditions for the
machine, see "Optimum Environmental
Conditions After Moving the Machine",
Maintenance and Specificcﬁons@.
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Problem

Causes

Solutions

An error message remains,
even if misfed paper is
removed.

* When a misfeed
message appears, it
remains until you open
and close the cover as
required.

* Paper is still jammed in
the tray.

After removing misfed paper, fully
open the front cover, and then close it.
For details about removing jammed
paper, see "Removing Jammed Paper",
Troubleshooting@®.

An error message remains
displayed even if the
indicated cover is closed.

One or more covers that are
not indicated are still open.

Close all the covers of the machine.

Original images are printed
on the reverse side of the

paper.

You may have loaded the

paper incorrectly.

* Load paper info the paper trays
with the print side down.

* load paper into the bypass tray
with the print side up.

Misfeeds occur frequently.

Using curled paper often
causes misfeeds, soiled
paper edges, or slipped
positions while performing
stack printing.

Take the stiffness out of the paper
with your hands to straighten out
the curl.

* Load the paper up side down so
that the curled edges face
downward. For details about
recommended paper, see
"Recommended Paper", Paper
Specifications and Adding Paper

.

* Lay paper on a flat surface to
prevent paper from curling, and
do not lean it against the wall. For
details about the proper way to
store paper, see "Paper Storage",
Paper Specifications and Adding
Pcper@.




When You Have Problems Operating the Machine

Problem Causes Solutions
Misfeeds occur frequently. The tray's side or end fences * Remove misfed paper. For details
may not be set properly. about removing jammed paper,

see "Removing Jammed Paper",

Troubleshooting@.

* Check that the side or end fences
are set properly. Also, check that
the side fences are locked. For
details about setting the side and
end fences, see "Changing the
Paper Size", Paper Specifications

and Adding Poper@.

turned off.

The machine makes a
clicking sound shortly after
the main power switch is

The main power switch You will hear a clicking sound inside
makes a clicking sound the machine when it shuts down. This is
inside the machine when the | not a malfunction.

main power is turned off
automatically.

* If you cannot make copies as you want because of paper type, paper size, or paper capacity

problems, use recommended paper. For details about recommended paper, see "Recommended

Paper", Paper Specifications and Adding Paper@.
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When Messages Are Displayed on the Control

Panel

Messages Displayed When Using the Copy Function

This section describes the machine's main messages. If other messages appear, follow their instructions.

¢ If you cannot make copies as you want because of the paper type, paper size or paper capacity

problems, use recommended paper. For details about recommended paper, see "Recommended

Paper", Paper Specifications and Adding Poper@.

* For messages that are not listed here, see page 101 "When You Have Problems Operating the

Machine".

Message

Causes

Solutions

"Cannot copy. Original is
being scanned by another
function."

The scanner function is in
use.

Cancel the current scan job. To do this,
press the [Clear/Stop] key on the
scanner screen fo display the message
"Clear/ Stop key was pressed. Stop
scanning?", and then press [Stop].

"Cannot dup. copy this size."

Duplex mode does not
support the selected paper
size.

Duplex mode supports the following
paper sizes: A4fl 81 /,x146],
81/,x13,81/,x11€], 81/ %140,
8]/4><13ﬂ, 8x13. Select one of
these sizes. For details, see "Duplex
Copying", Copy@.

"Cannot select Bypass Tray
in current setting."

The specified function is not
available with the bypass
tray.

Select a paper tray other than the
bypass tray.

"Cannot sort this size."

The specified paper size is
not available with the Sort

function.

This message appears when the
bypass tray is selected.

Use copy paper that is not longer than
356 mm (14").
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Message

Causes

Solutions

"Max. number of sets is nn."

(A figure is placed at nn.)

The number of copies
exceeds the maximum copy

quantity.

You can change the maximum copy
quantity from [Max. Number of Sets]
under [Copier Features]. For details
about Max. Copy Quantity, see
"Copier Features", Copy@.

"Original with this length

cannot be duplex scanned."

The specified custom length
is not available for duplex
printing from the ADF (e.g.,
2 Sided = 2 Sided, 2 Sided
= 1 Sided, 2 Sided
Combine).

Do not place originals that are longer
than 356 mm (14").

"Size error in Combine

mode."

The specified paper size is
not available with the

Combine function.

This message appears when the
bypass tray is selected.

Use copy paper that is not longer than
356 mm (14").

When the memory becomes full while using the copy function

Message

Causes

Solutions

"Reset orig., then press
[Resume] to scan and copy
the remaining originals."

The machine checked if the
remaining originals should
be copied, after the scanned
originals were printed.

To continue copying, remove all
copies, and then press [Resume]. To
stop copying, press the [Clear/Stop]
key.

Messages Displayed When Using the Facsimile Function

This section describes the machine's main messages. If other messages appear, follow their instructions.

* Settings that can be confirmed in System Settings or Facsimile Features on the control panel can

also be confirmed from Web Image Monitor. For details about how to confirm the settings from
Web Image Monitor, see Web Image Monitor Help.
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Message

Causes

Solutions

"Error occurred, and
transmission was cancelled."

A problem occurred in the
machine, or noise occurred
on the telephone line.

Press [Exit], and then send the

documents again.

"¥ Func. Problems Data will
be initialized."

There is a problem with the

fax.

Record the code number shown on the
screen, and then contact your service
representative. Other functions can be
used.

"Memory is full. Scanning
will be stopped and only
scanned page(s) will be
stored."

The memory is full.

If you press [Exit], the machine resumes
standby mode and starts transmitting

the pages that have been stored.

Check the pages that cannot be
transmitted on the Communication
Result Report, and transmit those
pages.

You can configure the machine to
transmit only the stored pages or
delete the stored pages when the
memory becomes full during scanning.
To change the setting, contact your

service representative.

"Put original back, check it
and press the Start key."

Original jammed during

Memory Transmission.

Press [Exit], and then send the

documents again.

"Updating the seftings... Re-
select dest./functions after
update finishes."

The destination list is being
updated from the network
using Web Image Monitor.

Wait until the message disappears. Do
not turn off the main power switch
while this message is displayed.
Depending on the number of
destinations to be updated, there may
be some delay before you can resume
operation. Operation is not possible
while this message is displayed.

* |If "Check whether there are any network problems." appears, the machine is not correctly

connected to the network or the settings of the machine are not correct. If you do not need to

connect to a network, you can specify the setting so this message is not displayed, and then the

[Facsimile] key no longer lights. For details about how to do this, see “Parameter Settings”, Fax®.




When Messages Are Displayed on the Control Panel

If you reconnect the machine to the network, be sure to set "Display" by configuring the
appropriate User Parameter.

Messages Displayed When Using the Printer Function

This section describes the principal messages that appear on the display panel, error logs or reports. If
other messages appear, follow their instructions.

Status messages

Message Status
"Loading toner" The machine is loading toner.
"Offline" The machine is offline.
"Please wait..."  This message might appear for a second or two while the

machine is preparing, performing initial adjustments, or adding
toner. Wait a while.

¢ The current environmental condition is outside the recommended
temperature range for the machine. Check the optimum
environmental conditions for the machine and move it to a
different location, or leave the machine for a while and allow it to
adapt to the environment.

"Printing..." The machine is printing. Wait a while.

"Ready" This is the default ready message. The machine is ready for use. No
action is required.

"Resetting job..." The machine is resetting the print job. Wait until "Ready" appears on
the display panel.

"Updating Certificate..." @Remote certificate is updating.

"Waiting for print data..." The machine is waiting for the next data to print. Wait a while.

Messages displayed on the control panel when using the printer function

* Before turning the main power switch off, see "Turning On/Off the Power", Getting Startled®.
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Message

Causes

Solutions

"gl\"(AH Remove misfeed in

Trays. Opn & cls Frt. Cov."

Open the front cover and
remove the jammed paper
from the paper feed path.

For details, see "Removing Jammed
Paper", Troubleshooting@.

"3 (A2) Open Front Cover

and remove the paper."

Remove the jammed paper
from the bypass tray. To
reset the error, open the

front cover and then close it.

For details, see "Removing Jammed
Paper", Troubleshooting@.

"%(B) Open Front Cover
and remove the paper."

Open the front cover and
remove the jammed paper
from the internal paper feed
path.

For details, see "Removing Jammed
Paper", Troub|eshooting@.

"8¥(B) (C) Open Front/Rear

Cover and remove misfeed."

Open the front/rear cover
and remove any jammed
paper from the internal
paper feed path.

For details, see "Removing Jammed
Paper", Troubleshooting@.

"$%(Y1) Remove misfeed in
Tray 2. Opn & cls Frt. Cov."

Open Tray 2 and remove
the jammed paper. To reset
the error, open the front
cover and then close it.

For details, see "Removing Jammed
Paper", Troubleshooting@.

8 (z1) Open Rear Cover

and remove misfeed"

Open the rear cover and
remove the jammed paper
from the paper duplex unit.

For details, see "Removing Jammed
Paper", Troubleshooting@.

"8 (22) Opn Tray1/R.Cov
& remove ppr. Opn & cls
F.Cov"

Open Tray 1 and the rear
cover, and then remove the
jammed paper. To reset the
error, open the front cover
and then close it.

For details, see "Removing Jammed
Paper", Troubleshooting@.

"WToner is almost empty."

The print cartridge is almost

empty.

For details, see "Adding Toner",
Maintenance and Specificaﬁons@.

"AJd toner. Replace
Toner Cartridge."

The toner has run out.
Replace the print cartridge.

For details, see "Adding Toner",
Maintenance and Specificcﬁons@.

"@Remote Cert. update
failed"

Updating the @Remote
certificate failed.

Turn the machine off, and then turn it
on again. If the problem persists,
contact your sales or service

representative.
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Message

Causes

Solutions

"Cannot
connect=>Comm.Serv.
Check proxy user/
password."

The proxy user name or

password is incorrect.

Check the proxy server settings, and
then change the user name and/or
password if they are incorrect.

"Change (Tray name) to the
following seftings:"

The size of the paper in the
tray does not match the
paper size specified in the

printer driver.

Press [Change] to change the paper
size and fype settings of the tray, as
indicated on the screen, and then load
the appropriate paper in the tray.
Otherwise, press [JobReset] to reset the
job, or press [Form Feed] to force
printing by specifying another tray.

"Cover Open. Please close
the indicated cover."

A cover of the machine is

open.

Close the cover as indicated on the
control panel.

"Duplex mode is in off

position for (tray name)"

The duplex mode for the
indicated tray is not
available.

Press [Change] to change the tray
sefting to allow duplex printing, or
press [JobReset] to reset the job.
Otherwise, press [Form Feed] to print
on one side of a sheet.

"Enter password."

User Restriction is enabled.

Contact your administrator for the
password.

"Failed to connect to server
for Remote Diagnostics."

The machine cannot
communicate with Remote

Communication Gate.

Check the connection to the Remote
Server Gate.

"Independent-supply toner"

Independent-supply toner is
set.

Use the toner recommended for this

machine.

"Load paper in (tray name)"

There is no paper in the
specified tray.

Load the specified paper in the tray,
press [JobReset] to reset the job.

"Prepare Replacement
Check print cartridge
replacement(s)."

The toner has run out.

Install a new print cartridge.

"Replacmnt Requrd Maint.
Kit"

You need to replace the
maintenance kit.

For details, see "Replacing
Maintenance Kit", Maintenance and

Specificotions@.
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Message

Causes

Solutions

"Replecmnt Requrd Drum
Unit"

You need to replace the
drum unit.

For details, see "Replacing Drum Unit",
Maintenance and Specificoﬁons@.

"Repl Requrd Soon Maint.
Kit"

You will need to replace the
maintenance kit soon.

Contact your sales or service

representative to obtain a new unit.

"Rplemnt Rgrd Soon:Drum
Unit"

You will need to replace the
drum unit soon.

Contact your sales or service

representative to obtain a new unit.

"Set the Drum Unit correctly."

The drum unit may not be
installed correctly.

Turn the machine off, and then install
the drum unit again.

"Set the Maintenance Kit

correctly."

The fusing unit may have not
been installed correctly.

Turn the machine off, and then install
the fusing unit again.

If the message continues to appear
after the unit is installed again, contact

your sales or service representative.

"Set the Toner Cartridge
correctly."

The print cartridge may have
not been installed correctly.

Turn the machine off, and install the
print cartridge again.

"Supply order has failed."

The automatic supply order

failed.

The message indicates the machine
tried to order the supplies.

"Waste Toner almost full"

The print cartridge must be
replaced when the life of the
waste toner is ending.

Prepare a new print cartridge.

"Waste Toner full"

The waste toner is full.

Replace the print cartridge. For details,
see "Adding Toner", Maintenance and

Specificcn‘ions@.

Messages Displayed When Using the Scanner Function

This section describes likely causes of and possible solutions for the error messages that appear on the

control panel. If a message not described here appears, act according to the message.
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Message

Causes

Solutions

"Authentication with the
destination has failed. Check
the seftings."

The user name and
password entered when
sending to a folder were
incorrect.

Enter the correct user name and

password, and try again.

"Cannot write on memory
device because remain.

space is insufficient."

The memory device is
insufficient and scan data
cannot be saved.

Replace the memory device.

"Cannot write on memory
device because the device is

write-protected."

The memory device is write
protfected.

Unlock the write-protection on the
memory device.

"Cannot write on memory
device. Check memory
device and machine sett."

The memory device is faulty,
or the file name contains a
character that cannot be
used.

e Check to see if the memory device
is defective.

* Check the memory device. It
might be unformatted, or its
format might be incompatible with
this machine.

e Check the file name set at the time
of scanning. For details on the
characters that can be used in file
names, see “Values of Various Set
ltems for Transmission Function”,
Scan®. Check with your system
administrator.

"Check the resolution and

reset nnn original(s)."

(A figure is placed at nnn.)

The scanned original
exceeded maximum data

capacity.

Specify the scan size and resolution
again. Note that it may not be possible
to scan very large originals at a high
resolution. See "Relationship between
Resolution and Scan Size", Scan®.

"Connection to PC failed.
Check the settings."

¢ The destination
computer name or
folder name is invalid.

e The entered user name
or password was
invalid.

* Check whether the computer
name and the folder name for the
destination are correct.

¢ Check that the user name and
password are correct.
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Message

Causes

Solutions

"Connection with the
destination has failed. Check
the status and connection."

The correct network settings
are not made.

* Check the network settings of the

client computer.

e Check that components such as
the LAN cable are connected
properly.

* Check that the server settings are
correct and the server is working
properly.

"Destination list has been
updated. Selected
destinations/ sender will be
cleared."

A specified destination or
sender's name was cleared
when the destination list in
the delivery server was
updated.

Specify the destination or sender's
name again.

"Exceeded max. data
capacity Check resolution
and Start."

The scanned data exceeded
maximum data capacity.

Specify the scan size and resolution
again. Note that it may not be possible
to scan very large originals at a high
resolution. See "Relationship between
Resolution and Scan Size", Scan®.

"Exceeded max. E-mail size.
Sending E-mail has been
cancelled."

The maximum e-mail size
has been exceeded.

* Increase the size of [Max. E-mail
Size].

e Set [Divide & Send E-mail] to [On
(per page)] or [On (per max.
size)]. See "Send Settings", Scan

"Exceeded max.memory
capacity. Do you want to
send the scanned data?"

The memory is full.

Specify whether to use the data or not.

"Exceeded max.memory
capa. Scanning will be
cancelled. Scanned data
will be cleared."

The memory is full.

Try one of the following measures:

* Wait for a while, and then retry
the scan operation.

* Reduce the scan area or scanning
resolution.

¢ Delete unneeded stored files.
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Message

Causes

Solutions

"Exceeded max. page
capacity. Do you want to
send the scanned data?"

The number of scanned

pages exceeded maximum
page capacity.

Select whether to send the data so far.

"Exceeded max. pg. per file.
Press [Write] to wrt. scanned
data to mem. device. Or
press [Cancel] to delete."

The scan could not be
completed because the
maximum number of pages
that can be scanned by this
machine was exceeded
during writing to the
Memory device.

Reduce the number of documents to be
written to the memory device and try

again.

"Memory device error.
Check the memory device."

A non-writable medium is
being used.

Use a different medium.

"Memory device not
detected. Insert the device."

There is no memory device
inserted.

Insert a memory device, or check to
see whether the memory device is

properly inserted in the media slot.

"Memory is full. Press [Werite]
to write current scanned
data to memory device. Or
press [Cancel] to delete."

The scan could not be
completed because there
was insufficient memory at
the time of saving to the
memory device.

Select whether or not to save the
scanned document to the memory
device.

"Original is being scanned
by another function."

The machine is using another
function such as copying.

Retry scanning after the operation with
the other function is completed.

"Sender's name is not
selected. Specify sender's

name."

You pressed [Start] key
without selecting a sender’s

name.

Select the sender’s name.

"Sending has failed."

The machine failed to send
the file. A network error may
have occurred during
sending.

Try the operation once more. If the
message is still shown, the network
may be crowded. Contact the
administrator.

"SMTP authent. E-mail
address and Administrator
E-mail address mismatch."

The SMTP authentication e-
mail address and the
administrator's e-mail

address do not match.

Contact the administrator.
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"Transmission has failed.

Insufficient memory in the
destination hard disk."

There is not enough space
on the receiver's hard disk.

Contact the receiver’s administrator.
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When Messages Are Displayed on Your
Computer Screen

Messages Displayed When Using the Scanner Function

This section describes likely causes of and possible solutions for the main error messages displayed on

the client computer when using the TWAIN driver. If a message not described here appears, act

according to the message.

Message

Causes

Solutions

"Call Service Please call

your service representative."

An unrecoverable error has
occurred in the machine.

Contact your service representative.

"Cannot connect to the
scanner. Check the network
Access Mask settings in User
Tools."

An access mask is set.

For details about an access mask,
contact your administrator.

"Cannot find "XXX" scanner
used for the previous scan.
"YYY" will be used instead."

("XXX" and "YYY" indicate

scanner names.)

The main power switch of
the previously used scanner
is not set to "On".

Check whether the main power switch
of the scanner used for the previous
scan is turned on.

"Cannot find "XXX" scanner
used for the previous scan.
"YYY" will be used instead."

("XXX" and "YYY" indicate

scanner names.)

The machine is not
connected to the network

correctly.

e Check that the previously used
scanner is connected to the
network correctly.

* Cancel the personal firewall of
the client computer. For details
about firewall, see Windows
Help.

¢ Select the scanner used for the

previous scan.
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Message

Causes

Solutions

"Clear Misfeed(s) in ADF."

A paper misfeed has
occurred inside the ADF.

* Remove jammed originals, and
then insert them again. For details
about how to remove jammed
paper, see "Removing Jammed
Paper", Troubleshooting®.

* When a misfeed occurs, replace

the jammed originals.

e Check whether the originals are
suitable to be scanned by the
machine.

"Communication error has
occurred on the network."

A communication error has
occurred on the network.

Check whether the client computer can
use the TCP/IP protocol.

"Error has occurred in the

scanner driver."

An error has occurred in the

driver.

e Check whether the network cable
is connected correctly to the client
computer.

¢ Check whether the Ethernet board
of the client computer is

recognized correctly by

Windows.

¢ Check whether the client
computer can use the TCP/IP

protocol.

"Error has occurred in the

scanner."

The application-specified
scan conditions have
exceeded the setting range
of the machine.

Check whether the scanning settings
made with the application exceed the

sefting range of the machine.

"Fatal error has occurred in
the scanner."

An unrecoverable error has
occurred on the machine.

An unrecoverable error has occurred
in the machine. Contact your service

representative.

"Insufficient memory. Close
all other applications, then

restart scanning."

Memory is insufficient.

* Close all the unnecessary
applications running on the client
computer.

¢ Uninstall the TWAIN driver, and
then reinstall it after restarting the
computer.
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Message Causes Solutions
"Insufficient memory. Reduce | Scanner memory is * Reset the scan size.

. " T
the scanning area. insufficient. e Lower the resolution.

* Set with no compression. For
details about the settings, see

TWAIN driver Help.

The problem may also be due to the
following causes:

* Scanning cannot be performed if
large values are set for brightness
when using halftone or high
resolution. For details about the
relationship between scan
sefttings, see "Relationship
between Resolution and Scan

Size", Scan®.

¢ |If a misfeed occurs, you might not
scan an original. Remove the
misfeed, and then scan the
original again.

"Invalid Winsock version. You are using an invalid Install the operating system of the

Please use version 1.1 or version of Winsock. computer or copy Winsock from the

higher." operating system CD-ROM.

"No response from the The machine or client o Check whether the machine or

scanner." computer is not connected to client computer is connected to
the network correctly. the network correctly.

* Disable the client computer's own
firewall. For details about firewall,
see Windows Help.

"No response from the The network is crowded. Wait for a while, and then try to
scanner." reconnect.
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Message

Causes

Solutions

"Scanner is in use for other

function. Please wait."

A function of the machine
other than the Scanner
function is being used such
as the Copier function.

* Wait for a while, and then

reconnect.

* Cancel the job that is being
processed. For example, press
[Exit], and then press the [OK]
key. Next, press the [Copier] icon
on the Home screen, and then
press the [Clear/Stop] key. When
the message appears on the
screen, follow the instructions to

cancel the job.

"Scanner is not available on

the specified device."

The TWAIN scanner function
cannot be used on this
machine.

Contact your service representative.

"Scanner is not available.
Check the scanner

connection status."

The machine's main power
switch is off.

Turn on the main power switch.

"Scanner is not available.
Check the scanner

connection status."

The machine is not
connected to the network
correctly.

¢ Check whether the machine is
connected to the network
correctly.

* Deselect the personal firewall
function of the client computer.
For details about firewall, see

Windows Help.

"Scanner is not available.
Check the scanner

connection status."

Network communication is
not available because the
machine's IP address could
not be obtained from the
host name. If only "IPvé" is
set to [Active], the IPv6
address might not be
obtained.

e Check whether the machine's host
name is specified in the Network
Connection Tool. For the WIA
driver, check the [Network
Connection] tab in the properties.

* Use Web Image Monitor to set
"LLMNR" of "IPv&" to [Active].

* In Windows XP, IPvé addresses
cannot be obtained from the host
name. Specify the machine's IPvé
address in the Network
Connection Tool.
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"Scanner is not ready. The ADF cover is open. Check whether the ADF cover is
Check the scanner and the closed.
options."

"The name is already in use. | You tried to register a name | Use another name.
Check the registered that is already in use.
names."
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10. Appendix
|
This chapter describes the trademarks.

Trademarks

PostScript and PostScript 3 are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corp. in the United
States and/or other countries.

The proper names of the Windows operating systems are as follows:
* The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Media Center Edition
Microsoft® Windows® XP Tablet PC Edition
* The product names of Windows 7 are as follows:
Microsoft® Windows® 7 Home Premium
Microsoft® Windows® 7 Professional
Microsoft® Windows® 7 Ultimate
Microsoft® Windows® 7 Enterprise
Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights to those marks.

Microsoft product screen shots reprinted with permission from Microsoft Corporation.
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